Appendix D

System Utilities

This appendix discusses the system utilities* and how to install them if they
were not pre-loaded at the factory. The system utilities diskette(s) include
installation programs for the following utilities:

0V suspend

PCMCIA

Hard disk drive physical format
SVGA

Touchpad

Enhanced IDE

Audio

CD-ROM

File transfer

The following sections discuss these utilities, how to install them, and how
they work.

t System utilities may differ according to system configuration.
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D.1

Zero-Volt (Hibernation) Suspend Utility

This program locates free continuous disk space and allocates it to save
base and extended memory as well as system registers. It prepares the
hard disk for the suspend-to-disk feature, including formatting and marking
of bad blocks.

When the system enters suspend mode (e.g., when you press the Suspend
button), the system saves all memory images and system status information
into the disk space. Press the power switch to return to the status prior to
entering suspend mode. If you do not run this program to allocate disk
space, this function will not work. Therefore, it is advisable to run this
program before using the system.

Syntax
PHDI SK [ opti ons]
where options:

| CREATE [ si ze] Create STD file or partition.
(/ FILE or /PARTI TI ON)

| DELETE Delete existing STD file or partition.
(/ FI LE or /PARTI Tl ON)

/I NFO Information on STD disk area(s).

/ REFORMAT / PARTI Tl ON Reformat existing STD patrtition.

/ If PHDISK is invoked without any parameters, it displays the

amount of disk storage required for the suspend to hard disk
feature and the current amount of storage available in the hard
disk.
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Table D-1 PHDISK Option Descriptions

Option

Description

ICREATE [size] /FILE

Create a suspend to disk file SAVE2DSK.BIN of a
specified size (in kilobytes). If the size parameter

is not specified, PHDISK will allocate the minimum
size required for the suspend to disk feature.

/CREATE [size] /PARTITION

Create a suspend to disk partition of a specified
size (in kilobytes). If the size parameter is not
specified, PHDISK will allocate the minimum size
required for the suspend to disk feature. This
option will mark out any bad blocks found during
the format operation.

The exact amount of disk storage required for the
suspend to disk may be calculated as follows:
Required storage = physical system memory size
+ video memory size(1024K) + 1K.

/REFORMAT /PARTITION

Reformat an existing suspend to disk partition.
Use this option if a previous suspend to disk
terminated in a read or write error. The option will
also mark out any bad blocks found during the
format operation.

/DELETE /FILE
or
/DELETE /PARTITION

Delete the suspend to disk file or partition or and
reclaim any space used by this feature. Use this
option conjunction with /CREATE to change the
size of the suspend to disk.

/INFO

Display extended information about the suspend to
hard disk.

Follow these steps to reserve a partition for the suspend-to-disk feature:

1. Insert the system utilities diskette into the diskette drive.

2. Atthe DOS prompt, type the following:

C\> A'\PHDI SK\ PHDI SK [/ CREATE...] €

3. Follow the screen instructions to complete the operation.
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D.2

PCMCIA Utility

Since the notebook’s compact size sacrifices expandability for portability,
the PCMCIA (Personal Computer Memory Card Industry Association) was
formed to provide expansion room for notebooks. PCMCIA cards give you
the expansion capabilities that add-on cards provide for desktop PCs. Such
cards include network cards, fax/data modem cards, memory cards, SCSI
cards, etc.

The PCMCIA utility prepares the PCMCIA slots on your notebook for use
with the system. Follow these steps to initialize your PCMCIA slots and
install the PCMCIA utility.

1. Insert the system utilities diskette into the diskette drive.

2. Atthe DOS prompt, type the following:
C:\> A\ PCMCl A\ | NSTALL e

3. Follow the screen instructions to complete the operation.

This installation program checks your PCMCIA slots and copies the DOS-
based card manager and if needed, the Windows card manager. If the
Windows option was selected, a program group and applications for the
card manager are created in Windows.
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D.3 HDFORM Utility

The HDFORM utility allows you to perform a physical format or low-level
format operation on your hard disk. Physical formatting arranges, optimizes
and prepares a hard disk for initial use.

Follow these steps to perform a physical format on your hard disk:
1. Insert the system utilities diskette into the diskette drive.
2. Atthe DOS prompt, type the following:

C\> A\ HDFORM HDFORM €

3. Follow the screen instructions to complete the operation.

/ The hard disk has been physically formatted by the

manufacturer. Do not reformat the hard disk unless absolutely
necessary. Physical formatting erases EVERYTHING on the
hard disk. Make backup copies of important files before you
proceed with physical formatting.

D.4 SVGA Drivers and Utilities

The SVGA display driver setup program allows you to install display drivers
for Windows applications and a number of DOS-based applications that lets
you to take advantage of the onboard VGA chip’s capabilities.

Follow these steps to install the display drivers:
1. Insert the system utilities diskette into the diskette drive.
2. Atthe DOS prompt, type the following:

C\> A\setup e

3. Follow the screen instructions to complete the installation.
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D.5 Touchpad Driver Setup
The touchpad works with most mouse drivers, but the bundled touchpad
driver supports special functions that work uniquely with the touchpad.
D.5.1 Installing the Touchpad Driver
1. Insert the touchpad driver installation disk into the diskette drive.
2. Atthe DOS prompt, type the following:
C\> a:\install e
Follow the screen instructions to complete the installation.
D.5.2 Configuring the Touchpad
You can configure the touchpad through DOS or by using the Touchpad
utility in Windows.
DOS
To see a list of the parameter settings and their descriptions, type the
following at the DOS prompt:
C.\> syntouch\syntouch /? e
You may run the touchpad driver with these parameters.
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Windows

Follow these steps to configure the touchpad under Windows:

1. In Windows, double-click on the Control Panel indicator of the Main
program group. The Control Panel window appears.

= Control Panel ﬂ
Settings Help
A
Coler Fontz
K.epboard Frinters
L3
L]
e
Drivers Sound
[Synaptics Touchpad Options

2.  Double-click on the Synaptics Touchpad utility indicator to configure
The Synaptics Touchpad Control Panel dialog box

the touchpad.
shows.

Category:

Orientation

Touchpad

L

Synaptics Touchpad Control Panel

Change appearance of the screen pointer

rColor and Size

SN
s & K
RIS

rPointer Growth

[T Grow while moving
Threzhold

siow[F[3] Fan

Delay

Help

rPointer Trails
[T Show trail: behind pointer

Length

For more options. click on the category list at left.
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You can configure different aspects of the touchpad including the
pointer, motion and orientation as well as touchpad shortcuts. Refer to
the online help for details.

D.6 Enhanced IDE Driver Setup
The enhanced IDE driver lets you to connect up to four IDE devices,
including hard disk and IDE CD-ROM drives. You will need to install this
utility to access any IDE devices you install in the optional docking station.
Follow these steps to install the enhanced IDE driver and utility:
1. Insert the IDE driver installation disk in the diskette drive.
2. Atthe DOS prompt, type the following:
C\> a:\install e
Follow the screen instructions to complete the installation. Please refer to
readme file for details.
D.7  Audio Driver Setup
The notebook has onboard 16-bit audio feature that allows you to
experience stereo-quality sound.
Follow these steps to install the audio drivers and utilities:
1. Insert the audio driver installation disk (1 of 2) in the diskette drive.
2. Atthe DOS prompt, type the following:
C\> a:\install e
Follow the screen instructions to complete the installation. Please refer to
readme file for details.
D-8 User's Manual



When prompted, select 240h as your I/O base address.
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D.8

CD-ROM Driver Setup

After installing the CD-ROM drive module into the notebook, you need to
install the CD-ROM driver. Follow these steps to install the CD-ROM
drivers:

1. Insert the CD-ROM installation diskette in the diskette drive.
2. Atthe DOS prompt, type the following:

C:\> A\ I NSTALL e

3. In the CD-ROM software installation menu, select Secondary
(170h) as the I/0 port address.

Follow the screen instructions to complete the installation.

Remember to reboot the system after installation for the
changes to take effect.
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D.9 Puma TranXit Quick Reference Guide

D.9.1 Introducing TranXit

TranXit™ for Windows is the fastest and easiest way to coordinate and
transfer files between two desktop PCs, notebooks and subnotes. TranXit
uses infrared or cable links to perform all your file maintenance tasks
without requiring you to exit Windows or copy files to a floppy disk.

In addition to transferring data between two computers, TranXit lets you
copy, move and delete files or create files and delete directories on a
remote computer. Best of all, TranXit's interface was designed with one
major consideration: YOU! You won't believe how simple TranXit is to use!

Here are a few of TranXit's features:

Synchronizes drives and directories on two computers with a click of a
mouse

Performs file and directory functions remotely with an infrared, serial
cable, or parallel cable link

Installs itself remotely on desktops, notebooks, and sub-notebooks
from your host computer without requiring a floppy diskette

Runs in the background, allowing you to transfer or synchronize large
amounts of data while you work on other applications

Includes a comprehensive and context sensitive on-line Help system
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D.9.2

Installing TranXit

Your copy of TranXit is licensed to run on two computers. TranXit may be
preinstalled on one or both of your computers. You can install TranXit
directly from the installation diskette.

To install TranXit on a computer with the Installation Diskette:
1. Insert the TranXit install diskette into the computer’s floppy disk drive.
2. Start Windows, if it is not already started.

3. Choose Run from the Program Manager File menu.

&

Type a: \ set up (or b: \ set up, if you are using the B drive) and
select OK or press e.

5. Follow the onscreen instructions.

The TranXit Setup dialog box lists these default setup options:
Install the files in the C:\TRANXIT directory.

Install all parts of the program, including the on-line Help file and the
Remote Installation files.

If you wish, you can enter the name of a different directory. You can also
deselect the Remote Installation or Help features, if you do not want to
install them.

D.9.3 Connecting the Two Computers
After you attach the cable or infrared devices and install TranXit on both
computers, you can connect the computers for data transfer.
To set up the connection:
1. On BOTH systems, choose Setup from the Connection menu.
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You

The Configure Connection Settings dialog box lets you select what kind
of connection you will use to transfer files between your two computers.
Select Serial Cable, Parallel Cable, or Infrared. If you select Change
Connection Settings, you will be prompted to select other information,
such as the port number, baud rate, and whether you wish to use Turbo
Mode. Turbo Mode increases performance, however you may notice a
significant decrease in mouse usability during data transmission. If you
plan to transfer large amounts of data in the background while working
on other applications, we recommend you not use Turbo Mode. You
can also select the infrared devices that you will use for the
connection. In most cases, you should select the highest baud rate
available for your device.

can enter information for more than one kind of connection, if you plan

(for example) to use infrared devices part of the time and cables the rest of
the time. You can also change the connection setup information at any
time after you install TranXit by choosing Setup from the Connection menu.
Please see section E.7 for any problems you experience with linking the two
computers.

To connect to the remote computer:

1.

Start TranXit on the local and remote computers and wait until the New
Window button and the New Remote Window menu option become
active (not grayed out).

On either computer, select the New Window button on the tool bar. If
you don't have a mouse, choose New Remote Window from the
Window menu.

When the two computers connect:

A new window appears on the local computer, displaying files and
directories of the remote computer.

The New Window and Clipboard buttons on the local computer become
active.

System Utilities
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D.9.4

A System Connected message appears on the remote computer. You
cannot issue any TranXit commands on the remote computer while the
local computer has control of it. (You can, however, execute other
applications on the remote computer while TranXit runs in the
background.)

You are now ready to copy files, synchronize directories, and perform other
TranXit tasks.

Synchronization

Synchronization is a powerful and flexible TranXit feature that lets you
coordinate the files and directories you use on both of your computers.
Normally, you use synchronization to make sure that you maintain the most
current version of all your files on (for example) your notebook you take
with you on business trips and the desktop. You can also synchronize files
on a local basis between (for example) your docking station and your
notebook. You can use synchronization in many other ways, such as
deleting all files from one computer that are not present on the other
computer.

The Synchronize Preview feature allows you to see in advance the result of
any synchronization command.

Here is one example of how to use synchronization. (TranXit on-line Help
has other examples.) This scenario assumes TranXit is installed on both
computers and that you have prepared the computers for data transmission.

Scenario Your notebook has the most current versions of the files you
use for your work. Your desktop computer also has most of
these files, but some are not the current version. You want to
update your desktop with the most current version of each file.

Synchronization Instructions

1. Start TranXit on both computers and set up an infrared or cable data
link between them.

D-14

User's Manual



10.

11.

Select the New Window button on the notebook, or select New Remote
Window from the Window menu.

Select the Sync button when it becomes active, or select Synchronize
from the Disk menu.

Select the directory on the notebook that contains the current version
of the files that you would like to synchronize. The directory list
appears on the left of the dialog box.

If necessary, select a different drive from the drop-down list below the
computer name. You can only synchronize one directory and its
subdirectories at a time.

Select the directory on the desktop that contains the older versions of
the files. The directory list appears to the right of the three arrow
buttons.

If necessary, select a different drive from the drop-down list below the
computer name.

Select the >> button if it is not already active.
Select the Options button to view Synchronize Options.

Select Copy Only Newer Files in the upper left grouping of four
options; select None of Above, the last option in the lower left of the
dialog box.

Select one or more of the Apply To options, if desired. Then select
OK.

Select Preview if you want to see in advance which files will be copied.
If the result is what you expected, select OK to exit the preview.

Select DONE on the Synchronize dialog box to synchronize your files.

System Utilities
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D.9.5 Working with Files

Copying Files and Directories

Follow these steps to copy files and directories:

1. Select the files or directories you wish to copy. You can select multiple
files within a directory by holding down b while you select your files.
You can also use j to select a group of files by selecting the first file
and holding down j while you select the last file in the group.

2. Drag the selected files to the destination drive icon or directory icon.
3. Release the left mouse button.

TranXit prompts you to confirm the mouse action and/or to confirm the
copy if it will overwrite a file of the same name.

/ These prompts do not appear if you have disabled the Mouse
Action and/or File Replace confirmations.

4. Select Yes to overwrite the file listed in the Confirmation dialog box;
select Yes to All to overwrite all files that have the same name; select
No to skip overwriting the file listed in the Confirmation dialog box;
select Cancel to cancel the Copy command.

A message on the screen lists the name of each file as it is copied.
When the message disappears, the copy is complete.

/ You can also copy by using the mouse to select the tool bar Copy
button after you have selected the files or directories.
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Deleting a File or Directory

TranXit lets you delete files or directories from your local or remote
computer. Follow these steps:

1. Select the files or directories you want to delete.

2. Choose Delete from the File menu, press Del, or select the Delete
button on the tool bar.

The Delete dialog box appears. The name of the file or directory you
selected appears in the Delete box. You can change this information,
if necessary. You can enter wildcard characters in the Delete edit box,
such as *.doc to select all files in the current directory whose names
have a .doc extension.

3. Select the OK button or press e to delete the files or directories.

You are prompted to confirm the deletions.

/ This prompt only appears if you have set File and/or Directory
Delete confirmations on the Confirmation dialog box, or if the files
have System or Read Only attributes.

4. Press e or select YES to delete the files or directories listed in the
Confirmation dialog box, press A or select YES TO ALL to delete all
selected files or directories, press N or select NO to skip deleting the
file or directory listed in the Confirmation dialog box, or press | to
cancel the delete command.

Moving a File or a Directory

You can move files and directories from one location to another on the
same computer or from one computer to another by using the mouse or by
using the Move command. Follow these steps:

1. Select the files or directories you want to move.
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Hold down the left mouse button, then hold down b while you drag the
selected files or directories to the destination directory icon or drive
icon.

Release the left mouse button and b.

TranXit prompts you to confirm the mouse action and also to confirm
the move if it will overwrite a file of the same name. (These
confirmations do not appear if you have disabled them).

You may confirm or cancel the move by clicking the appropriate
buttons.

/ You can also move files or directories by clicking on the tool bar
Move button after you have selected them.

Renaming a File or a Directory

Follow these steps to rename a file or a directory:

1.

2.

Select the file(s) or directory.

Choose Rename from the File menu. The Rename dialog box appears
and the name of the file appears in the Rename box.

In the To: box enter the new name of the file or directory. You can use
wildcards to rename a group of files. If you try to rename a file with a
name that already exists, you are asked to confirm that you want to
overwrite the other file.

If necessary, change the name in the Computer: box so you are
renaming the file on the correct computer.

You may need to do this if you have identically named files in the
same named directory on both your local and remote computers.

Click the OK button or press e to rename the file or directory. You can
click the Cancel button or press | to abandon the rename.
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D.9.6 Clipboard

TranXit allows you to send and receive data stored in the Windows
clipboard or Windows for Workgroups clipbook between the local and
remote computers. This is a very convenient feature for users who wish to
print, transfer or edit sections of very large files without copying the entire
file to the other computer. You can also use the clipboard to exchange text,
some device independent graphics, spreadsheet data, and many other file

types.

Any information in the remote computers clipboard will be

overwritten.

To send clipboard data to the remote computer:
1. Start TranXit on both computers and set up a link.

2. Click the New Window button on either computer, or select New
Remote Window from the Window menu. The two Clipboard buttons
on the toolbar should now be enabled.

3. Click the Send Clipboard toolbar button. The information you
previously placed in the clipboard is sent to the remote computer’s
clipboard.

To receive clipboard data from the remote computer:
1. Start TranXit on both computers and set up a link.

2. Click the New Window button on either computer, or select New
Remote Window from the Window menu. The two Clipboard buttons
on the toolbar should now be enabled.

3. Click the Receive Clipboard toolbar button. The information you
previously placed in the clipboard is sent to the local computer’s
clipboard.
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D.9.7

You can now paste the clipboard information to any application that
supports the Windows clipboard. See the Windows manual if you are not
sure how to copy, cut or paste information to and from the Windows
clipboard.

Troubleshooting

For more detailed Troubleshooting ideas, please see the Readme file in the
TranXit Program Group.

Problems Linking Two Computers

Be sure there are no interrupt IRQ conflicts. The most common cause
of this is sound cards residing on IRQ?7.

Be sure the cables or infrared devices are securely connected to both
computers. Serial cables need to be screwed in completely in order to
function properly.

Be sure you selected the same baud rates for both computers (serial
and infrared only).

Be sure you selected the correct port on each computer.

If you see the error message “No fixed disk found on remote
computer,” you have probably set an Access Level of None for the
hard disk drive on the remote computer. TranXit will “find” the disk
drive again if you change its Access Level to Read/Write or Read Only
within the remote computer’'s Security menu.
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Problems with Remote Install

In some cases your local computer will need to be slowed down during
the remote install process. This will most likely occur when the remote
computer is an older system. In order to do this, you will need to
change the baud rate parameters for the remote install process so that
the remote computer can accept data transferred from the host. To
change the baud rate parameters you will need to edit the
TRANXIT.INI file. Use an editor such as Windows Notepad or DOS
Edit to open TRANXIT.INI. The baud rate parameters can be found
under the section labeled “[Advanced], RemotelnstallBaud =". The
default baud rate settings is 57,600. Other possible settings are 9600,
19200, 38400, and 115200. Remember to save your changes to the
TRANXIT.INI file before you exit the editor.

Problems Transferring Files

Be sure you assigned a different name to each computer.

If you can't see the files you want to copy or move, check the filter
options on the View menu.

Don't use your computer’'s COM ports for other applications while you
are transferring data with serial cables.

Problems Using Infrared Data Transmission

Be sure there is no direct sunlight, fluorescent light, or flashing
incandescent light close to the infrared connections.

Avoid interference from remote control units (wireless headphones and
audio devices) pointed at the infrared connections.

Do not point one of the devices more than 30 degrees away from the
other device’s receiver.

Do not place objects between the two connections that might interfere
with line-of-sight data transmission.

System Utilities
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D.9.8

Do not move the infrared devices away from each other during data
transmission. This may cause disconnection if you are using infrared
devices with no external power source.

Do not place the infrared devices too far apart, especially if they do not
use an external power source.

Problems Using the Clipboard

If an image that has been sent via one of the clipboard functions
appears distorted on the receiving system, it may be due to the fact
that it is a device dependent bit map (DDB). DDBs are created with
the intention that they will only be displayed on the original system.
This distortion commonly occurs when the original system is operating
in a video mode that displays a higher number of colors. For example,
the original machine is running in 256 color mode and the receiving
machine is displaying Windows in only 16 colors. This can be
corrected by running Windows Setup and matching the video modes
on both systems.

If you receive the error message “Error in Clipboard Return”, or a
message stating you have “Insufficient Clipboard Memory”, the
problem is most likely caused by low memory on the receiving system.
To correct the problem you can free more memory on the receiving
system or save the clipboard to a file and use the TranXit file manager
to copy the file to the receiving system.

TranXit Information

Puma has established a Bulletin Board number for TranXit customers who
wish to access information on new product developments, promotions and
new releases. To access the Bulletin Board, configure your modem as
follows and dial 408-970-8766 (USA). The Bulletin Board System supports
up to 14400 BPS with communication settings of 8 data bits, 1 stop bit, and
parity set to none.
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Wireless Connectivity Bundle  $129.00

This Puma Wireless Connectivity Bundle lets you maximize your productivity by allowing you to
make easy, reliable, wireless file transfers. Your new notebook comes with the ability to
transfer and synchronize files without cables using TranXit™ for Windows and your
computer’s built-in infrared transmitter. To take full advantage of this powerful feature, you'l
want to upgrade to TranXit PowerPro™ and get an infrared adapter for your desktop PC. For
a limited time this special connectivity kit, including the TranXit PowerPro upgrade and a
Puma Serial Infrared Adapter is being made available to new notebook owners for only
$129.00. If you already have infrared capability for your desktop PC, then the only thing
you're missing is the TranXit PowerPro upgrade.

TranXit PowerPro™ Upgrade  $69.95

If you already have the infrared adapter or cables, then all you need is the TranXit PowerPro™
upgrade. TranXit for Windows has your notebook and desktop PC connected. Now you can
maximize your productivity by turning on the power with a TranXit PowerPro upgrade.

Print directly from your notebook to an IrDA compliant printer (like the HP LaserJet 5 laser printer)
Automatically synchronize files so that both computers have only the latest version of a document
Send print jobs through your desktop PC to a remote printer, over an infrared connection

Use the virtual clipboard feature to share information with other infrared systems

Access and transfer files while out of the office through your built-in modem

Puma Fast Infrared Adapter  $299.00

If speed is important, then the Puma Fast Infrared Adapter is the right choice for transferring
files at amazing speeds. With a Puma Fast Infrared Adapter for your desktop PCs and
notebook, you can transfer data at rates up to 1.15 megabits per second at distances of up to
10 feet. That means you can transfer a 20-page word document in one second. The Puma
Fast Infrared Adapter consists of a ISA board that can be easily inserted in your desktop, and
an attached infrared transceiver. The Puma Fast Infrared Adapter is also available for
notebooks in PCMCIA format. This adapter features a built-in transceiver and is ready to use
by simply placing the card in the PCMCIA slot of your notebook. Both Puma Fast Infrared
Adapters come with a full version of Tranxit PowerPro.

Serial Infrared Adapter’  $99.00

Upgrade your desktop computer to support infrared data transfer. This infrared adapter plugs
into the serial port of your desktop computer. Working together with the built-in infrared
device on your notebook, this adapter allows you to transfer or synchronize data between your

notebook and your desktop — without cables!

! Designed to comply with the IrDA specification



Yes, send me the TranXit PowerPro™ upgrade today!

Puma Wireless Connectivity Bundle $129.00

QTY. TOTAL

TranXit PowerPro Software Upgrade $69.95

Serial IR Adapter $99.00

Puma Fast Infrared Adapter

PCMCIA (notebook) $299.00

ISA (desktop $299.00

TranXit User’'s Manual / Master Disk $19.95

Shipping and Handling
CA residents please add sales tax
Total Amount Enclosed

Name:

$ 8.00

Company:

Shipping Address (No P.O. Boxes):

City State ZIP

Disk Size: Q35 a5.25
Q VISA O MasterCard
Cardholder Name:

Q Amex

Cardholder Signature:

Account Number:

Expiration Date:

Check Enclosed Make payable to Puma Technology™
Fax Order To Or Call
1-800-418-0303 1-800-774-PUMA
Other Countries call 408-492-0387

for pricing and ordering

or Mail Order To:
Puma Technology
P.O. Box 4300

Santa Clara, CA 95056

PUMA/ACER: Prices subject to change without notice. TranXit, TranXit PowerPro and Puma Technology are trademarks

of Puma Technology Inc.
trademarks or registered trademarks of their respective manufacturers.

Acer is a registered trademark of Acer Incorporated. All other referenced products are






How do three FREE issues of PC LapTop
magazine register with you?

Register with us and
we’ll send you three!

All you have to do to receive your complimen-
tary issues of PC LapTop is complete and mail
this form to Puma Technology. With your free
issues, you'll receive a subscription offer for 12
issues of PC LapTop at a special rate of just
$19.95 (US) - just for TranXit owners.

Your registration entitles you to receive the
TranXit 2.0 upgrade for a nominal fee of $9.95
(shipping & handling). TranXit 2.0 includes
print redirector, pop-up help balloons, a
configurable toolbar, enhanced file transfer
performance, and right mouse button support.
Call us at 1-800-774-PUMA and we'll send you
the TranXit 2.0 upgrade, or just complete and
mail this form, and we'll send you the three free
issues of PC LapTop magazine.

Last Name

First Name

Title

Company

Address (1)

Address (2)

City State

Country Zip Code

Phone

Fax

PUMA

PUMA/ACER

PLEASE FOLD HERE AND

Puma Technology
Attention: Special Offer
P.O. Box 4300

Santa Clara, CA 95056
USA

PLACE
STAMP
HERE




